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Information Techonology Class IX Code. 402 (Questions and Answers ) 

Unit 1 Chapter 1 Communication Skills 

 (Topic-1 : Meaning of Communication Page No. 1.22 

3. Answer the following questions 
 
A. Define Communication 
Ans. The exchange of ideas and information between individuals or groups through verbal or non 
verbal methods of expression is called communication. 
 
B. Write down the importance of communication. 
Ans.  Importance of communication 

1. It helps the flow of information 

2. It helps people by removing misunderstanding amongst them and create of thoughts and 

expression. 

3. It also educates people. 

C.  Write in 50 words how you will communicate/send messages if you: 
a. Define Communication. 
b. Write down the importance of communication. 
c. Write in 50 words how you will communicate/send messages if you: 

i.  are trapped in a life alone 

ii. are travelling in a car and tyre got punctured and you are looking for assistance. 

iii. are left in the washroom of a theatre and it’s the last show that you had gone to watch. 

i. Hello! I am stuck in the lift of the mall. Please come and help. There is no one else with 
me. Please hurry the lights and fan is also not working and making difficult to breathe. 
ii. Hi! Sorry to bother you but my car is parked just across the street and I have a flat tyre. I 
am not familiar with how to change it could you please come and guide me? It would mean a 
lot to me! 

ii. Hey!! Aman, I am stuck at the washroom of the movie theatre. It was supposed to be the 
last show and seems like everyone is gone. Please come and help. 

iii.  

Unit 1 Chapter 2 Self Management Skills 

Page No. 1.38 

SHORT ANSWER QUESTIONS 
 

1. Mention the factors that help in building self-confidence. 

Ans. The factors that boost self-confidence are:- 
a. Social Factors 

b. Cultural Factors 

c. Physical Factors 
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2. Point out two social factors that can result in low self-confidence. 

Ans. Two social factors that can result in low self-confidence are:- 
a. Childhood 

b. Societal influences 

 
3. How do you think behavior of the parents towards their children can affect one’s self-

esteem? 

Ans. When a child feels safe, loved and accepted, his/her self-esteem groups and parents play 
a vital role as at the initial stage of their life children are mostly influenced by their parents. 
 
4. Write down a few simple tips that can boost one’s self-confidence. 

Ans. Few tips to boost self-esteem. 
a. Positive thinking  

b. Cleanliness 

c. Interaction with positive people. 

d. Enjoying small pleasures of life. 

Unit 1 Chapter 4 Entrepreneurial Skills 

Page No. 1.77 

2. Answer the following questions: 
 
1.  What is business plan? 
Ans. A business plan is a document that defines in detail a companies objectives and how it plans 
to achieve its goals. 
 
2. What is opportunity analysis? 
Ans. Opportunity analysis refers to establishing demand and competitive analysis, and studying 
market conditions to be able to have a clear vision and plan strategies accordingly. 
 
3. What is market survey? 
Ans. An investigation into the state of the market for a particular product or service, including an 
analysis of consumers needs & preferences. 
 
4. What is project? 
Ans. A project is defined as a sequence of tasks that must be completed to attain a certain 
outcome. 

 

Page No. 1.80 

2. True and False questions 
i. True 
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ii. True 

iii. True 

iv. True 

v. True 

vi. True 

vii. True 

viii. True 

ix. True 

x. True 

 
 

Unit 1 Chapter 5 Green Skills 

Page No. 1.84 

 
Answer the following questions: 
 

a. What are natural resources? 

Ans. Natural resources are resources that are drawn from nature and used with few 
modifications. 
 
b. Why should we protect natural resources? 

Ans. We should protect natural resources because most of these resources are limited in 

supply and need to be conserved for future use. 

 

c. What do you understand by the term “Environment”? 

Ans. All the biotic and abiotic factors present in nature together form the environment. 
 
d. Explain how the environment affects societies? 

Ans.  
i. The size, density, and distribution of population are influenced by the physical features 

of country 

ii. The topography of a country affects human habitation, clothes diet and animal 

husbandry. 

iii. Occupation too is influenced by the environment. 

 
e. What is an ecosystem? Give example. 

Ans. An ecosystem is a geographic area where plants, animals, and other organisms, as well as 
weather and landscape, work together to form a bubble of life. Eg. Terrestrial ecosystem 
 
f. What are the main factors that cause imbalance to ecosystem? 

Ans.  Main factors are as following: 
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i. Degradation of Land and Soil erosion 

ii. Deforestation 

iii. Water Pollution 

iv. Mining practices 

v. Industrial and Atmospheric pollution 

 
g. List five ways to conserve natural resources. 

Ans.  
i. We should use more and more renewable resources. 

ii. We should plant trees and stop deforestation wherever possible. 

iii. We should stop wastage of water. 

iv. We should minimize using plastic and polythene bags. 

v. We should use LED and CFL bulbs to save electricity.  

 
h. Write a note on environmental protection and conservation. 

Ans. Environmental conversation is the practice of preserving the natural world to prevent it from 
collapsing as a result of human activities such as unsustainable agriculture, deforestation and 
burning fossil fuels. 
 
2. True/False 

a. True 

b. False 

c. False 

d. False 

e. False 

Page No. 1.86 

a. What is green economy? 
Ans. One that results in improved human well-being and social equity, while significantly reducing 
environmental risks and ecological sacrifices is known as Green Economy. 
 
b. What are the various sectors which the green economy promotes? 
Ans. The sectors are as following: 
(i) Forest Management. 
(ii) Sustainable Agriculture 
(iv) Use of clean technologies. 
 
c. What do you understand by the tem “green skills”? 
Ans. The skills required for promoting the green economy are known as green skills. 
 
d. Why is green economy important in today’s world? 
Ans. Importance of green economy are: 
1. Cleaner technologies are being developed. 
2. Recycling and reusing are welcomed through awareness in all sector of society. 
3. The green economy always try to understand the value of the national capital and try to invest 
in the strong areas. This helps in increasing per capita income of a nation. 
 



5 
 

e. Name the first country to adopt Green Growth Strategy. 
Ans. South Korea (Seoul) 
 

 
 

Information Techonology Class IX Code. 402 (Questions and Answers ) 

Unit 3 Chapter 8 Digital Documentation 

 (Topic-1 : Start the Word Processing Application) Page No. 2.68 

Q. 1: What is word processing software? How does it works. 
 

Answer : A word processor, or word processing program, does exactly what the name implies. 

It processes words. It also processes paragraphs, pages, and entire papers. Some examples of 

word processing programs include Microsoft Word, WordPerfect (Windows only), AppleWorks 

(Mac only), OpenOffice.org and LibreOffice etc. 

 Q. 2: What are the advantage of using LibreOffice? 
 

Answer : Advantages of LibreOffice 
 

Here are some of the advantages of LibreOffice over other office suites: 
 

 No licensing fees: -LibreOffice is free for anyone to use and distribute at no cost. Many 

features that are available as extra cost add-ins in other office suites (like PDF export) 

are free with LibreOffice. There are no hidden charges now or in the future. 

 Open source: - You can distribute, copy, and modify the software as much as you wish, 

in accordance with the LibreOffice Open Source licenses. 

 Cross-platform: - LibreOffice runs on several hardware architectures and under 

multiple operating systems, such as Microsoft Windows, Mac OS X and Linux. 

 Extensive language support: - The LibreOffice user interface, including spelling, 

hyphenation, and thesaurus dictionaries, is available in over 100 languages and 

dialects. LibreOffice also provides support for both Complex Text Layout (CTL) and 

Right to Left (RTL) layout languages (such as Urdu, Hebrew, and Arabic). 

 Consistent user interface: - All the components have a similar “look and feel,” making 

them easy to use and master. 

 Integration: - The components of LibreOffice are well integrated with one another. 

 All the components share a common spelling checker and other tools, which are used 

consistently across the suite. For example, the drawing tools available in Writer are 

also found in Calc, with similar but enhanced versions in Impress and Draw. 

 –You do not need to know which application was used to create a particular file. For 

example, you can open a Draw file from Writer. 

 Granularity: - Usually, if you change an option, it affects all components. However, 

LibreOffice options can be set at a component level or even at document level. 

 File compatibility: - In addition to its native OpenDocument formats, LibreOffice 
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includes support for opening and saving files in many common formats including 

Microsoft Office, HTML, XML, WordPerfect, Lotus 1-2-3, and PDF. 

 No vendor lock-in: - LibreOffice uses OpenDocument, an XML (eXtensible Markup 

Language) file format developed as an industry standard by OASIS (Organization for the 

Advancement of Structured Information Standards). These files can easily be unzipped 

and read by any text editor, and their framework is open and published. 
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 You have a voice: - Enhancements, software fixes, and release dates are community- 

driven. You can join the community and affect the course of the product you use. 

 Q. 3: How a new file has been open n the LibreOffice writer? 
 

Answer : Let us see how easy it is to enter text in a Writer document. We have to start a new 

document as we have already shown how to start it. 

Document area is the area where you type your text. The flashing vertical bar is called the 

insertion point and it represents the location where the text will appear when you type keep 

the cursor at the text insertion point and start typing the text. 

You do not need to press Enter to start a new line. As the insertion point reaches the end of 

the line, Writer automatically starts a new one. You will need to press Enter, to add a new 

paragraph. 

 Q. 4: Name the different components in LibreOffice? 
 

Answer : LibreOffice is a freely available, fully-featured office productivity suite. Its native 

file format is Open Document Format (ODF), an open standard format that is being adopted 

by governments worldwide as a required file format for publishing and accepting documents. 

LibreOffice can also open and save documents in many other formats, including those used by 

several versions of Microsoft Office. 

LibreOffice includes the following components. 

Writer (word processor) 

Writer is a feature-rich tool for creating letters, books, reports, newsletters, brochures, and 

other documents. You can insert graphics and objects from other components into Writer 

documents. Writer can export files to HTML, XHTML, XML, Adobe Portable Document Format 

(PDF), and several versions of Microsoft Word files. It also connects to your email client. 

Calc (spreadsheet) 
 

Calc has all of the advanced analysis, charting, and decision making features expected from a 

high-end spreadsheet. It includes over 300 functions for financial, statistical, and 

mathematical operations, among others. The Scenario Manager provides “what if” analysis. 

Calc generates 2D and 3D charts, which can be integrated into other LibreOffice documents. 

You can also open and work with Microsoft Excel workbooks and save them in Excel format. 

Calc can also export spreadsheets in several formats, including for example Comma Separated 

Value (CSV), Adobe PDF and HTML formats. 

Impress (presentations) 
 

Impress provides all the common multimedia presentation tools, such as special effects, 

animation, and drawing tools. It is integrated with the advanced graphics capabilities of 

LibreOffice Draw and Math components. Slideshows can be further enhanced using Fontwork 
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special effects text, as well as sound and video clips. Impress is compatible with Microsoft 

PowerPoint file format and can also save your work in numerous graphics formats, including 

Macromedia Flash (SWF). 

Draw (vector graphics) 
 

Draw is a vector drawing tool that can produce everything from simple diagrams or flowcharts 

to 3D artwork. Its Smart Connectors feature allows you to define your own connection points. 

You can use Draw to create drawings for use in any of the LibreOffice components, and you 

can create your own clip art and then add it to the Gallery. Draw can import graphics from 

many common formats and save them in over 20 formats, including PNG, HTML, PDF, and 

Flash. 

Base (database) 
 

Base provides tools for day-to-day database work within a simple interface. It can create and 

edit forms, reports, queries, tables, views, and relations, so that managing a relational 

database is much the same as in other popular database applications. Base provides many 

new features, such as the ability to analyze and edit relationships from a diagram view. Base 

incorporates two relational database engines, HSQLDB and PostgreSQL. It can also use dBASE, 

Microsoft Access, MySQL, or Oracle, or any ODBC compliant or JDBC compliant database. Base 

also provides support for a subset of ANSI-92 SQL. 

Math (formula editor) 
 

Math is the LibreOffice formula or equation editor. You can use it to create complex 

equations that include symbols or characters not available in standard font sets. While it is 

most commonly used to create formulas in other documents, such as Writer and Impress files, 

Math can also work as a standalone tool. You can save formulas in the standard Mathematical 

Markup Language (MathML) format for inclusion in web pages and other documents not 

created by LibreOffice. 

 Q. 5: What is Menubar and name the different menus in it? 
 

Answer : The menu bar contains all the commands for working with LibreOffice writer. It 

contains a list of all the available operators as well as the commands for editing, viewing, 

arranging, formatting and printing documents and the objects contained in them. Most of the 

menu commands are only available when you are creating or editing any Document. 
 

 

S.No Menu Operations 

1. File This menu contains general commands for working with Draw documents, 
such as open, close and print. To close LibreOffice Writer, click Exit. 

2. Edit The commands in this menu are used to edit Draw documents (for example, 
copying and pasting). 

3. View Sets the display properties of Draw documents. 
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4. Insert This menu allows you to insert elements, such as graphics and guides, into 
Draw documents. 

5. Format Contains commands for formatting the layout and the contents of your 
document. 

6. Tools This menu provides tools for LibreOffice Draw as well as access to language 
and system settings. 

7. Modify Contains commands for modifying objects in your document. 

8. Window Contains commands for manipulating and displaying document windows. 

9. Help The Help menu allows you to start and control the LibreOffice Help system. 

 

 

 Q. 6: What is cursor? How can it be used with mouse? 
 

Answer : When you move the mouse, Writer turns the mouse pointer into an I-beam pointer. 

If you move the mouse over an area where you cannot type any text, the mouse pointer turns 

back into the traditional arrow, pointing up to the left. 

To move the cursor with the mouse, just point and click the left mouse button once. The 

blinking cursor appears where you clicked the mouse. 

If you have a blank page or a blank area at the end of your document, you can move the 

cursor anywhere within this blank area by following these steps: 

1. Move the mouse pointer over any blank area past the end of a document. Writer defines 

the end of a document as the spot where no more text appears. To find the end of a 

document, press Ctrl+End. 

In a new document: - The end of the document is in the upper-left corner where the 

cursor appears. 

In a document with existing text: - The end of the document is the last area where text 

appears (including spaces or tabs). 

2. Move the mouse pointer over any blank area past the end of the document. Notice that a 

Left, Center, or Right Justification icon appears to the right or bottom of the I-beam mouse 

pointer. 

3. Make sure the correct justification   icon   appears   next   to   the   mouse   pointer. 

For example, if you want to center-justify your text, make sure the Center Justification icon 

appears at the bottom of the I-beam pointer. 
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Unit 3 Chapter 8 Digital Documentation 

(Topic-2 : Edit The Document) Page No. 2.88 

 

 Q.1: What is Text editing? 
 

Answer: The ability to change text by adding, deleting and rearranging letters, words, 

sentences and paragraphs. Text editing is the main operation users perform in word 

processors, which typically also handle graphics and other multimedia files. 

  

 Q. 2: What is the basic difference between REDO and UNDO? 
 

Answer: Undo 
 

The Undo feature is a quick way to cancel the recently introduced change and restore the 

document to its previous state. This is especially useful when the last performed operation 

was particularly destructive to the document, like in a situation when you select all of its 

content and accidentally delete it. 

In order to revert the last action, activate the Undo command in two ways: 
 

 Press the Undo button on the toolbar. 

 Press the Ctrl+Z combination on your keyboard. 
 

Redo 
 

The Redo feature lets you revert the last undo operation. This means that the document 

returns to the state it was in before you performed the undo. 

In order to revert the last undo operation, activate the Redo command in two ways: 
 

 Press the Redo button on the toolbar. 

 Press the Ctrl+Y combination on your keyboard. 
 

Just like with undo, many redo levels are supported, so you can usually go forward as many 

steps as required. 

 Q. 3 : What is the difference between copy & paste and cut & paste? 
 

Answer: The Copy operation will just copy the content from its original place and create a 

duplicate copy of the content at the desired location without deleting the text from it's the 

original location. 
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The Cut operation will cut the content from its original place and move the content from its 

original location to a new desired location. 

 Q. 4: Describe different text selection criterias? 
 

Answer: The most common method of selecting a text is to click and drag the mouse over the 

text you want to select. Following table lists down a few other simple methods that will help 

you in selecting text in different scenarios − 
 

S.No Component Selection Method 

1 Selecting text between two 
points 

Click at the start of the block of text, hold down Shift, 
and click at the end of the block. 

2 Selecting a single word Double-click anywhere on the word you want to select. 

3 Selecting a paragraph Triple-click anywhere on the paragraph you want to 
select. 

4 Selecting a sentence Hold down the Ctrl key and click anywhere in the 
  sentence you want to select. 

5 Selecting a column of text Hold down Alt, click and hold the mouse button, and drag 
over the column you want to select. 

Note that only one part of the document can be in the selected state. If you have one portion 

of the document in selected state and as soon as you try to select any other part of the 

document, previous part will automatically be de-selected. 

 Q.5: Why we use text find and replace? How it can be done? 
 

Answer: In text documents you can find words, formatting, styles, and more. You can 

navigate from one result to the next, or you can highlight all results at once, then apply 

another format or replace the words by other text. 

To find text within the whole document, open the Find & Replace dialog without any active 

text selection. If you want to search only a part of your document, first select that part of 

text, then open the Find & Replace dialog. 

To Find Text 
 

Step 1 – Click on Edit menu and then Find & Replace to open the Find & Replace dialog. 

Step 2 - Enter the text to find in the Find text box. 

Step 3 - Either click Find Next or Find All. 
 

When you click Find Next, Writer will show you the next text that is equal to your entry. You 

can watch and edit the text, then click Find Next again to advance to the next found text. 

You can open the find and replace dialog box by pressing Ctrl+Shift+F. 
 

Alternatively, you can use the icons at the lower right of the document to navigate to the 

next text or to any other object in the document. 

When you click Find All, Writer selects all text that is equal to your entry. Now you can for 
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example set all found text to bold, or apply a character style to all at once. 

To Replace Text 
 

Unlike searching text, replacing text cannot be restricted to the current selection only. 

 
Step 1 – Click on Edit menu and then Find & Replace to open the Find & Replace dialog. 

Step 2 - Enter the text to search in the Find text box. 

Step 3- Enter the text to replace the found text in the Replace with text box. Either 

click Replace or Replace All. 

When you click Replace, Writer will search the whole document for the text in the Find box, 

starting at the current cursor position. When text is found, Writer highlights the text and 

waits for your response. Click Replace to replace the highlighted text in the document with 

the text in the Replace text box. Click Find Next to advance to the next found text without 

replacing the current selection. 

When you click Replace All, Writer replaces all text that matches your entry. 
 

 Q.6: What is the difference between find style and find format? 
 

Answer: To Find Styles 
 

You want to find all text in your document to which a certain Paragraph Style is assigned, for 

example the "Heading 2" style. 

Step 1 – Click on Edit menu and then Find & Replace to open the Find & Replace dialog. 

Step 2 - Click Other options to expand the dialog. 

Step 3 - Check Paragraph Styles. 
 

The Find text box now is a list box, where you can select any of the Paragraph Styles that are 

applied in the current document. 

Select the style to search for, then click Find Next or Find All. 
 

To Find Formats 
 

You want to find all text in your document to which a certain direct character formatting is 

assigned. Finding formats only finds direct character attributes, it does not find attributes 

applied as part of a style. 

Step 1 – Click on Edit menu and then Find & Replace to open the Find & Replace dialog. 

Step 2- Click More Options to expand the dialog. 

Step 3 - Click the Format button. 
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These will be a new window the formatting option after clicking format button 

Step 4 - Click Find Next or Find All. 

 Q. 7: What are non printing characters? 
 

Answer: Non-printable characters are parts of a character set that do not represent a written 

symbol or part of the text within a document or code, but rather are there in the context of 

signal and control in character encoding. They are used to tell word processors and certain 

applications, like Web browsers, how a document is supposed to look. 

Non-printable characters are also known as non-printing characters or control characters. 

These characters are such as paragraph marks, line breaks, tab stops, and spaces. 



14 
 

For selecting nonprinting characters just click Toggle Formatting Marks on the standard 

toolbar or press Ctrl + F10 on the keyboard. 

After clicking the toggle formatting marks you will able to see some characters which are 

there in the document but not visible till you press the nonprinting character button. 

If you do not want to these characters are not visible so you just need to again click the 

Toggle Formatting marks then you they are remove from the document. 

 Q. 8: Why Spellcheck has been done? And how it can be done? 
 

Answer: You can manually check the spelling and grammar of a text selection or the entire 

document. 

To check the spelling and the grammar of a text, the appropriate dictionaries must be 

installed. For many languages three different dictionaries exist: a spellchecker, a hyphenation 

dictionary, and a thesaurus. Each dictionary covers one language only. 

The spellcheck starts at the current cursor position, or at the beginning of the text selection. 

Step 1 - Click in the document, or select the text that you want to check. 

Step 2 - Choose Tools - Spelling and Grammar this is available on the standard toolbar. 
 

Step 3 - When a possible spelling error is encountered, the Spellcheck dialog opens and 

LibreOffice offers some suggested corrections. 

Step 4 - Do one of the following: 
 

 To accept a correction, click the suggestion, and then click Correct. 

 Edit the sentence in the upper text box, and then click Correct. 

 To add the unknown word to a user-defined dictionary, click Add to Dictionary. 
 

Step 5 – Click ok after completing the spellcheck 

 

Unit 3 Chapter 8 Digital Documentation 

(Topic-3 : Formatting The Document) Page No. 2.115 

 Q. 1 Define page style and write the steps for creating new page style. 
 

Answer: LibreOffice uses page styles to specify the layout of a page, including the page 

orientation, background, margins, headers, footers, and text columns. To change the layout 

of an individual page in a document, you must create and apply a custom page style to the 

page. 

To Define a New Page Style 
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Step 1 - Select View and then click on Styles and then click Formatting. 

Step 2 - Click the Page Styles icon. 

Step 3 - In the list of page styles, right-click an item, and then choose New. 

Step 4 - On the Organizer tab, type a name in the Name box. 

Step 5 - Do one of the following: 
 

Step 5.1 - To apply the custom page style to a single page, select the default page style that 

is used in your document in the Next Style box. 

Step 5.2 - To apply the custom page style to more than one page, select its name in the Next 

Style box. To stop using the style, insert a manual page break and assign it a different page 

style. 

Step 5.3 - Use the tabs in the dialog to set the layout options for the page style, and then 

click OK. 

 Q. 2 What is font style and size. How it can be changed. 
 

Answer: LibreOffice Writer allows you to use different fonts with different size. You can 

change your document's appearance by changing the fonts and their size. Usually you use 

different fonts for paragraphs and headings. It is important to learn how to use different 

fonts. This chapter will teach you how to change a font and its size in simple steps. 

We will understand in brief the font buttons that are used to change the front style and size. 

Following steps show you a few font related buttons. 

Step 1 − Select the portion of text the font of which needs to be changed and click the Font 

Type button to list down all the fonts available. 

Step 2 − Try to move the mouse pointer over the listed fonts. You will see that the text font 

changes when you move the mouse pointer over different fonts. You can use the Font Scroll 

Bar to display more fonts available. Finally select a desired font by clicking over the font 

name in the list. 

Step 3 − Similar way, to change the font size, click over the Font Size button which will 

display a font size list. You will use the same procedure to select a desired font size that you 

have used while selecting a font type. 

 Q. 3 Define different type of text alignments. 
 

Answer: Let us discus the alignment tools. There are four types of paragraph alignment 

available in Writer — left-aligned, center-aligned, right-aligned, and justified. 

Left-Aligned Text 
 

A paragraph's text is left aligned when it is aligned evenly along the left margin. Here is a 
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simple procedure to make a paragraph text left-aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click the Align Text 

Left button available on the Home tab or simply press the Ctrl + L keys. 

Center Aligned Text 
 

A paragraph's text will be said center aligned if it is in the center of the left and right 

margins. Here is a simple procedure to make a paragraph text center aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click the Center button 

available on the Home tab or simply press the Ctrl + E keys. 

Right-Aligned Text 
 

A paragraph's text is right-aligned when it is aligned evenly along the right margin. Here is a 

simple procedure to make a paragraph text right-aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click the Align Text 

Right button available on the Home tab or simply press the Ctrl + R keys. 

Justified Text 
 

A paragraph's text is justified when it is aligned evenly along both the left and the right 

margins. Following is a simple procedure to make a paragraph text justified. 

Step 1 − Click anywhere on the paragraph you want to align and click the Justify button 

available on the Home tab or simply press the Ctrl + J keys. 

When you click the Justify button, it displays four options, justify, justify low, justify high 

and justify medium. You need to select only the justify option. The difference between these 

options is that low justify creates little space between two words, medium creates a more 

space than low justify and high creates maximum space between two words to justify the 

text. 

 Q. 4 What is the different between Subscript and Superscript? 
 

Answer: Superscript is writing text slight above the normal align text like this text Super script 

and Subscript is writing text slight below the normal align text like this text Sub script. 
 

Subscript and superscript is a type of style where 
 

Step 1 - Select the portion of text the font of which needs to be changed. 
 

Step 2 – Click on format then select tool for any of the style subscript or superscript. 

we can perform same tack by clicking the tool available in the formatting toolbar. 

 Q. 5 What is text case and how it can be changed? 
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Answer: Changing text case means converting text from lower to upper or upper to sentence 

case and so on. This can be achieved by following the steps as shown below- 

Step 1 - Select the portion of text the font of which needs to be changed. 
 

Step 2 – Click on format then select tool for any of the style or UPPERCCASE or lowercase or 

Cycle case or Sentence case. 

Or you can do this by right click on the selected text then select character and then character 

a new character window open. 

Select the effect given in the list. 
 

 Q. 6 What is the difference between paragraph and page formatting? 
 

Answer: Formatting paragraph is to modifies the format of the current paragraph, such as 

indents and alignment. 

All page properties for Writer text documents, like for example the page orientation, are 

defined by page styles. By default, a new text document uses the “Default” page style for all 

pages. If you open an existing text document, different page styles may have been applied to 

the different pages. 

 Q. 7 What are steps to add border on the paragraph? 
 

Answer: 
 

Step1 : You can select the order and the background of the paragraph by clicking on border 

tab of the paragraph window. You can select the line arrangement of the paragraph border 

and also the size and type of the line of the border. By clicking on the color you can select 

the color of the border and if you want to select the shadow on the border you can also elect 

the type and the color of the shadow. 

Step 2: For background select the area tab and inn this tab we have different options like 

color, gradient, bitmap, pattern and hatch. With the help of color you can select the 

background color and with the help of gradient, bitmap and pattern will give you the texture 

and pattern. 

Step 3: There will be the options of the gradient and bitmap. 
 

 Q. 8 Why numbering and bullets are used in the document? How it can be inserted 

in the document? 

Answer: LibreOffice Writer provides bullets and numbers to put a list of items in a nice order. 

This will teach you simple steps to create either the bulleted or the numbered lists in simple 

steps. 

Create a List from Existing Text 
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This is very simple to convert a list of lines into a bulleted or numbered list. Following are the 

simple steps to create either bulleted list or numbered list. 

Step 1 − Select a list of text to which you want to assign bullets or numbers. You can use any 

of the text selection method to select the portion of text. 

Step 2 − Click the Bullet Button triangle to display a list of bullets you want to assign to the 

list given in the formatting toolbar. You can select any of the bullet style available by simply 

clicking over it. 

Step 3 − If you are willing to create a list with numbers, then click the Numbering 

Button triangle instead of the bullet button to display a list of numbers you want to assign to 

the list. You can select any of the numbering style available by simply clicking over it. 

 Q. 9 What is header and how it is different from footer? 
 

Answer: Headers and footers are parts of a document that contain special information such as 

page numbers and the total number of pages, the document title, company logo, any photo, 

etc. The header appears at the top of every page, and the footer appears at the bottom of 

every page. 

The following steps will help you understand how to add header and footer in a Writer 

document. 

Step 1 − Click the format tab and then click on the page. 
 

Step 2 – A new page style window will open then you can change the settings of the header 

and footer like do you want to have a header or footer on the page and margin, height etc. 

Step 3 – Now double click at the top of the page then you are able to see the header area, 

where you can wright whatever you want to wright in it. 

You can also format header, insert page number, insert border and background and you can 

also delete the header 

Step 4 – For footer double click at the bottom of the page then you are able to see the footer 

area, where you can wright whatever you want to wright in it. 

You can also format footer, insert page number, insert border and background and you can 

also delete the footer. 

 Q. 10 Do we insert page break within a document? How? 
 

Answer: yes we can insert page brake within the document. For insering page brake you just 

need to the following step. 

Step 1 :Page break is moving the text after the courser or to add a new page in the 

document. 
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Step 2: Click on insert and then click on page break then a new page after the courser 

position. 

 Q. 11 What are special characters? How they can be inserted? 
 

Answer: Special character are some character which are not available on the keyboard so 

while creating some document something we need to write them so these character can be 

inserted just like an image is inserted. 

Step 1 – Click on insert tab and then click on special character tool. 
 

Step 2 – a new will appear with character which are available on the keyboard and some are 

not so we have to select the character which you have to insert then press insert. 
 

This window have the option to search the character by name , when you select the character 

it will give the description of that character decimal and hexadecimal value of that character 

and it also give you the recent and favorite characters also. 
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Unit 3 Chapter 8 Digital Documentation 

(Topic-4 : Create and Use Table) Page No. 2.124 

 Q. 1 Why tables are used in the writer? 

Answer: A table is a structure of vertical columns and horizontal rows with a cell at every 

intersection. Each cell can contain text or graphics, and you can format the table in any way 

you want. 

 Q. 2 How you can create a table explain with example? 
 

Answer: The following steps will help you understand how to create a table in a Word 

document. 

Step 1 − Click the table menu and then click on insert table. 
 

Step 2 - This will display a table window where you can select the number of rows and 

columns and the style of table you want to create, name of the table and the heading option 

also. 

Step 3 – Press insert on the table window it will insert the table on the page. 
 

 Q. 3 What is difference between adding a row and a column ? 
 

Answer: You can insert a column or a row by diffrent ways one is with the help of table menu. 
 

Type 1 - Click on table menu and then click on insert it will give you the option of row and 

column. 

Row can be inserted before and after any row so you can select it in the menu. The rows tool 

will give a window of rows where you have asked to enter the number of rows and the 

position before or after any row the position is of the row decided by the courser position. 

Same way columns are inserted before or after of any column. As rows window shows the 

columns window have insert number and before and after selection. 

Type 2 – Right click on the position where you want to insert row or column and the same 

menu will appear as by clicking the table menu. Do whatever you want to with table. 

Type 3 – press tab at the last cell of the table it will add one more empty row in the table. 
 

 Q. 4 How can we remove a table? 
 

Answer: Just like rows and columns are inserted by the same way we can delete the rows and 

columns. Select the cell and click on the operation you want to perform or right click on the 

cell and then the delete row and column menu appear. 
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 Q. 5 what is the difference between split cell and merge cell? 
 

Answer: Splitting means dividing one cell into multiple cells. 

Step 1 – click on the table and then click on the Split cells. 

Step 2 – a new window of split cells window will appear where you have to provide the 

number of spilt cells into and the direction horizontally or vertically. 

Step 3 – Press ok 
 

Merging cells means joining multiple cells into one cell. 

Step 1 - select the cells for those you want to merge. 

Step 2 - click on the table and then click on the merge cells. 
 

Or select the cells to be merge and right click on the selected cell and then press merge cell. 
 

Unit 3 Chapter 8 Digital Documentation 

(Topic-5 : Print The Document) Page No. 2.128 

 

 Q. 1 Why print preview is required? 
 

Answer: When you are ready for printing your document, it is always recommended to 

preview the document before you send the document for final printing. During preview of the 

document you might discover that the set margin is not appropriate or many items may not 

look good after printing so better to fix them after having a preview of the document. You 

can also have the option to specify which pages to print, select a printer, specify the paper 

size on which you want to print, and set the other printing options. 

 Q. 2 What is page layout and how it can be change at the time of printinig? 
 

Answer: Consider you are done with previewing and proofing your document and ready for the 

final printing. 

The following steps will help you print your LibreOffice Writer document. 
 

Step 1 − Open the document for which you want to print. Next click the File menu and click 

on the print tool or press Ctrl + P. 

Step 2 − You will have the new printing window where you can set various other printing 

optionspri available. Select from among the following options, depending on your 

preferences. This print window have two type of properties one is general and other is 

libreoffice specific. 

Q. 3 Can borders be excluded at the time of printing of any document? If yes give 
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the procedure ? 

Answer: Yes borders can be removed at the time of printing of any document. You will move 

to the new printing window when you click on the print in file menu or press Clt+p where you 

can set various other printing options available. Select from among the following options, 

depending on your preferences. This print window have two type of properties one is general 

and other is libreoffice specific. 

 

Unit 3 Chapter 8 Digital Documentation 

(Topic-6 : Print The Letters Using Mail Merge) Page No. 2.140 

Q. 1 What is mail merge in word processing? 
 

Answer: Mail merge is a feature within most data processing applications that enables users to 

send a similar letter or document to multiple recipients. It enables connecting a single form 

template with a data source that contains information about the recipient’s name, address 

and other predefined and supported data. 

 Q. 2 Why it is used in documents? 
 

Answer: Mail merge primarily enables automating the process of sending bulk mail to 

customers, subscribers or general individuals. Mail merge works when a data file is stored that 

includes the information of the recipients to whom the letter is to be sent. This file can be a 

spreadsheet or database file containing separate fields for each different type of information 

to be merged within the letter. 

 Q. 3 What steps are involved in a mail merge? 
 

Answer : There are 8 steps in mail merge 

Step 1 - Select starting document 

Step 2 - Select document type 

Step 3 - Insert address block 

Step 4 - Selecting the address block 

Step 5 - Create salutation 

Step 6 - Adjust layout 

Step 7 - Edit document and insert extra fields 

Step 8 - Save, print or send 

 Q. 4 How address block can be created in mail merge? 
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Answer: there is a step to create an address list - 
 

Step 1: When you click on create list it will open you a new window whish have some empty 

fields like title, first name, last name, address etc. These fields are not fix you can add or 

delete any field by just clicking on the modify button given on this window. 

 Q. 5 What is the salutation in mail merge? 
 

Answer: : The salutation is the initial greeting, for example, Dear Mr Amit Sharma '. In step 5, 

select the salutation that will appear in the letter. 

 Q. 6 What is the difference between save, print and mail a document? 

Answer: The last step is to print mail or save documnet. In step 8, you can save the original 

sample letter, save the merged document, print the letters right away or, if you created 

email messages, send them. 

Let us start with the save document a new window will open if you click on Save merged 

document. This window will give you the save as options to save document, if you want a 

specific range of records to save so you can give the number of records stars from and ends 

to. 

If you want to print the document then you have to click on print merged document. You will 

have a new window. This window have printer option where you can select the name of the 

printer and next is record option where you can select the number of records if all then tick 

first if specific number then in the second option select the number starts from and ends to. 

If you want to email the letter to the records then you have to click on email document. You 

will have a new window which has some mailing options. It will take the email id of records 

from the record itself with the filed name email address, you can change the field name by 

clicking on the “to” in email options and select the different field if that filed have the email 

addresses. Enter the subject and send letter in email as HMTL massage or attachment form 

selecting send as. 
 

Unit 4 Chapter 9 Electronic Spreadsheet 

(Topic-1 : Creat A Spreadsheet) Page No. 2.150 

 Q. 1 Define Spreadsheet? 
 

Answer : A spreadsheet is a sheet of paper that shows accounting or other data in rows and 

columns; a spreadsheet is also a computer application program that simulates a physical 

spreadsheet by capturing, displaying, and manipulating data arranged in rows and columns. 

The spreadsheet is one of the most popular uses of the personal computer. 

 Q. 2 Explain different parts of LibreOffice Calc? 
 

Answer :There are so many parts in Libreoffice calc like title bar, menu bar, toolbar,formula 
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bar, individual cell, sheet tab and status bar. 

 Q. 3 What is cell range ? 
 

Answer : – Range of selected columns called are column range. For example let us select 

column “ A “ from 4 to 10 so the highlighted cells are selected columns range and the address 

of shown in active cell address field A4:A10. The “ : ” the colon symbol is use to represent 

the address of continues cells. 

 Q. 4 What is the address of the first cell represented by Range1? 
 

Answer : The address of first cell is A in the range 1. 
 

 Write the cell range represented by Range 2. 

Answer : The address of first cell is 3 in the range 2. 
 

 Q. 5 What is the name of the cell range along a row? 
 

Answer : The number of cells spread across the row and columns. The address of cell range is 

B3 to E3. 

 Q. 6 What is the name of the cell range along a column? 
 

Answer : The address of cell range is B3 to B9. 
 

 Q. 7 Give the number of cells in the cell range represented by Range 3. 
 

Answer : The address of cell range is B2 to C7. 
 

Unit 4 Chapter 9 Electronic Spreadsheet 

(Topic-2 : Enter and Edit The Text in Spreadsheet) Page No. 2.159 

 Q. 1 What is are difference between label and value? 
 

Answer : Label - Any text entered by using keyboard is called label. The label may include 

letter, number, symbol and special symbols. Labels are left align by default. For entering the 

label you need to just activate the cell type text or number and press enter or Navigation 

keys. 

Value - Any number entered by using keyboard is called value. The value can only have 

number. Values are right align by default. 

 Q. 2 How formula entered in the calc? 
 

Answer : For creating a formula you need to type in the Formula Bar. Formula begins with '=' 

sign. When building formulas manually, you can either type in the cell addresses or you can 

point to them in the worksheet. Using the Pointing method to supply the cell addresses for 

formulas is often easier and more powerful method of formula building. When you are using 
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built-in functions, you click the cell or drag through the cell range that you want to use when 

defining the function’s arguments in the Function Arguments dialog box. 

 Q. 3 What are different arithmetic functions in calc? Explain with example? 
 

Answer : All formulas begin with an equals sign. The formulas can contain numbers, text, 

arithmetic operators, logic operators, or functions. The basic arithmetic operators (+, -, *, /) 

can be used in formulas using the "Multiplication and Division before Addition and Subtraction" 

rule. Instead of writing =SUM(A1:B1) you can write =A1+B1. Parentheses can also be used. The 

result of the formula =(1+2)*3 produces a different result than =1+2*3. 

 Q. 4 What is the operator precedence? 
 

Answer : As we have studied in mathematics about the BODMAS in 6th or 7th class. BODMAS 

stands for "brackets, order(power), division, multiplication, addition, subtraction". Hear we 

follow the same precedence. 

 Q. 5 What is Average function explain with example? 
 

Answer : Average function is use to find the average of the given numbers or cell address in 

the function. Let us take the previous example of calculating the average of sale made by 

each salesman so we can do this way with function =(B2+C2+D2+E2)/4. But with the Average 

function =average(B2,C2,D2,E2). The result in both the cases will remain same. 

 

Unit 4 Chapter 9 Electronic Spreadsheet 

(Topic-3 : Format Data in The Spreadsheet) Page No. 2.169 

Q.1 How cell format can be changed? 
 

Answer : In libreOffice calc a cell can have any type of data. This cell data can change or 

formatted using formatting toolbar or cell formatting tool. It is also possible to format the 

cell using Format cells dialog window. 

Q. 2 How the decimal values can be inserted in any cell? 
 

Answer : We can change the format of any number or numbers, select the cell or cells and 

right click on the selected cells. Then you have the formatting cell window select category 

type as number and then click on the decimal places (given below) as 2 or 3 or whatever as 

par your requirement in options on that same window. 

 Q.3 Define different tools available in cell format window? 
 

Answer : There are many options in the Format cells window shown below - 
 

S.No Tool Description 

1. Number You can set the format of the cell depending on the cell content. 
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2. Font You can set the font of text on this tab. 

3. Font effect You can set the effects on the font of text on this tab. 

4. Alignment You can set the alignment of text on this tab. 

5. Border You can set border of cell with this tab. 

6. Background You can set background of cell with this tab. 

7 Protection You can set cell protection option with this tab 

 

 Q. 4 What is the use of scientific category in calc? 
 

Answer : There are some other formats also there in the worksheet in the calc like date, 

time, scientific etc. Date and time has different formats of date and time on the cell so just 

need to select the cell and select the format of your choice. 

 Q. 5 How drag and drop help us to assign values to the other cells? 
 

Answer : The formula can be implemented to the other cells in calc using drag and drop or we 

can simply copy the formula and post it to the desired cell. Steps associated for copying are, 

first click on the cell where the formula is and then right click and select copy, and then 

select the desired cell where you want to paste that formula and then right click and select 

paste. 

Unit 4 Chapter 9 Electronic Spreadsheet 

(Topic-4 : Use Referencing) Page No. 2.175 

 

 Q. 1 Define referencing in calc? 
 

Answer : Most formulas you create include references to cells or ranges. These references 

enable your formulas to work dynamically with the data contained in those cells or ranges. 

For example, if your formula refers to cell C2 and you change the value contained in C2, the 

formula result reflects new value automatically. 

 Q. 2 What is the difference between absolute and relative referencing? 
 

Answer : Relative Reference - The row and column references can change when you copy the 

formula to another cell because the references are actually offsets from the current row and 

column. By default, Excel creates relative cell references in formulas. 

Absolute Reference - The row and column references do not change when you copy the 

formula because the reference is to an actual cell address. An absolute reference uses two 

dollar signs in its address: one for the column letter and one for the row number for 

example, $A$5. 

 Q. 3 What is mixed referencing explain with example? 
 

Answer : Both the row or column reference is relative and the other is absolute. Only one of 

the address parts is absolute for example, $A5 or A$5. In $A5 column is fixed row is variable 
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and in A$5 row is fixed column is variable. 

Unit 4 Chapter 9 Electronic Spreadsheet 

(Topic-5 : Introduce The Types of Charts in Cals) Page No. 2.180 

Unit 4 Chapter 9 
 (Topic – 5) 

 
 Q. 1 What are the advantages of using chart? 

 

Answer : Advantages of chart in spreadsheet 
 

1. Aggregating Data - Worksheet charts enable you to condense or summarize large amounts 

of data within a small, rectangular section of your worksheet. For instance, you could create 

a worksheet with rows and columns containing ten years of stock closing prices that would 

leave you glassy-eyed and numb if you tried to analyze them. Instead, use Calc's charting 

tools to create a line or X-Y scatter chart that can help you visualize the price fluctuations of 

your stock over the years. 

2. Expose Patterns and Trends - Charts can help you see patterns and trends that may be 

obscured within your worksheet cells. Line, bar and area charts enable you to deduce the 

direction and momentum of data over time or in terms of another unit of measurement. For 

instance, a plot of average, daily global temperature and sea levels over the past century 

could help climatologists distinguish between a short-term climate aberration and a bona 

fide, global warming or cooling trend. 

3. Expose Outlying Data - Scatter and line charts can help you spot outliers or data items 

that seem out of place or unrelated to the rest of the data. Outliers may be caused typing 

mistakes, instrument malfunctions or simply random, nonsensical data that can safely be 

ignored. Not only do outlying data run counter to any patterns or trends shown in the rest of 

the data, they can skew or distort averages, sums and other analytical calculations you may 

want to perform. 

4. Communicate Complex or Abstruse Data - Charts can help you or the people you share 

your Calc worksheets with grasp data that is hard to visual or comprehend in words or 

numbers. Pie charts help viewers grasp percentages, ratios and proportions instantly. Bar and 

column charts enable you to compare and rank sets of data without even looking at the raw 

numbers they represent. 

 Q. 2 Describe the different type of charts? 
 

Answer : There are various chart types available in Calc. The type of chart are given in the 

table – 
 

S.No   Type   Description  
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1. Column Column chart shows data changes over a period of time or 
illustrates comparisons among items. 

2. Bar A bar chart illustrates comparisons among individual items. 

3. Line A line chart shows trends in data at equal intervals. 

4. Pie A pie chart shows the size of items that make up a data series, 
proportional to the sum of the items. It always shows only one data 
series and is useful when you want to emphasize a significant 
element in the data. 

5. Area An area chart emphasizes the magnitude of change over time. 

6. X Y (Scatter) An xy (scatter) chart shows the relationships among the numeric 
values in several data series, or plots two groups of numbers as one 
series of xy coordinates. 

7. Stock This chart type is most often used for stock price data, but can also 
be used for scientific data (for example, to indicate temperature 
changes). 

8. Surface A surface chart is useful when you want to find the optimum 
combinations between two sets of data. As in a topographic map, 
colors and patterns indicate areas that are in the same range of 
values. 

9. Bubble Data that is arranged in columns on a worksheet, so that x values are 
listed in the first column and corresponding y values and bubble size 
values are listed in adjacent columns, can be plotted in a bubble 

chart. 

10 Column and 
line 

A column and line chart is the combination of both line and column 
chart values of a number of data series. 

 
 
 
 
 
 

Unit 5 Chapter 10 Digital Presentation 

(Topic-1 : Introduction to Digital Presentation  

&  

Topic 2 : Describe The Quality of Good Presentation) Page No. 2.186 

  Q. 1 Define Presentation ? 

 Answer : Presentation skills are required in almost every aspect of life. The way you present 

your skills, your ideas, your inventions or product, even your own self makes a  huge difference 

to the audiences.A good presentation is the key to your audience heart and mind. Computer 

presentation this task easier and efficient. 

 Q. 2 What are the advantages of computer presentation? 
 

Answer : There are number of advantages of using computer presentation. 
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 We can use presentation slides as cheat sheet where we just note down the important 

points, facts and figures and just remember the details or explanation we want to tam 

about.

 Presentation gives us better control over what we are talking about which saves lots of 

time and efforts to write down everything using pen or chalk.

 Presentation facilitate you to make use of graphs, tables and figures which was 

difficult to use in non-computer based presentation.

 Computer presentation allow you to make use of templates to create your 

presentation for easily and quickly. `

 Computer presentations also allows you to reuse your presentation at multiple places 

and you can also make them secure using password protection.

 Q. 3 List the basic elements of computer presentation? 
 

Answer : Elements of presentation 
 

 Interface: the interface comprises of the screens, dialog boxes, buttons, panes, and 

other parts of the application window. The biggest part of the interface is the working 

area i.e. the pane for creating and editing slides. He toolbar appears on the top of the 

screen which comprises of buttons and menus to insert, edit, and format content on 

the pane.

 Content: Content include static text, graphs, images, listed items, tables and audio/ 

video clips. Most of the commands to include any of these are available on insert tab

 Slides: slides are the pages of presentation software tool. It provide you with the place 

where you insert your content. You can insert or delete or reorder slides according to 

your requirement.

 Animation: animation is an element of computer presentation tool. It makes your 

content move on a slide. It allows you to select the way the content appear and 

disappear from your slide. The animation can be done manually using mouse click or 

can be automated by adding timer to animation.

 Slideshow: the final slide presentation that your audience sees is the most important 

and distinct element of computer presentation. It allows you to view your presentation 

in a running mode not the in the interface where you created or can edit presentation.

  

 Q. 4 What are points to be kept in mind while preparing a presentation? 
 

Answer : Points to for good presentations are as follows – 
 

1. Pay attention to the audience - How you start and finish your presentation will make all 

the difference. The complete structure of the presentation must comprise of introduction 

slide, body of your presentation and the concluding slide. 

2. Limit the amount of text - keep your slides simple and focused on the prime agenda. 
 

3. Be design savvy - A good design can make or break a presentation. Consistent design makes 
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you look more professional. 

4. Format for perfection - in order to keep your presentation attractive and interesting 

formation plays an important role. 

 

Unit 5 Chapter 10 Digital Presentation 

(Topic-3 : Create A Presentation) Page No. 2.196 

Q.1 Define slides in Impress. 
 

Answer : A slide is like a page in a document. The presenter shows these slides in a display 

device (projector, monitor) to the target audience for better understanding while he speaks 

about content in each slide. 

Q.2. what is the difference between slide transition and animation? 
 

Answer : 
 

Slide Transition: This sectionis used for transition of the slide. It allows you to modify 

features like transition speed, sound effects, manual/automated transition, etc. 

Animation: This is used or transition of objects on a slide. These transitions are added for 

dramatic emphasis and calling attention to objects. 

 Q.3 What is the use of slide Pane? 
 

Answer : Slide pane - it is a vertical pane appear on left side of the window. It contains 

thumbnails of the slides in your presentation. We use the slides pane to manage the slides of 

a presentation, as you can reorder, insert and delete the slides using this pane easily if 

required. Clicking a slide in this pane displaysit in large size in workspace, where you can 

add, delete or modify content or effects to make it complete. 

 Q.4 What is the difference between template and layout? 
 

Answer : Template - A PowerPoint template is a pattern or blueprint of a slide or group of pre 

designed slides. Templates can contain layouts, theme colors, theme fonts, theme effects, 

background styles, and even content. 

Layout - Layout are the different type of slides which are used for different tasks and 

purposes. 

 Q.5 what is the difference between template and styles? 

Answer : Template - A PowerPoint template is a pattern or blueprint of a slide or group of pre 

designed slides. Templates can contain layouts, theme colors, theme fonts, theme effects, 

background styles, and even content. 

Style – style is the related to formatting of the slide. We can create our own style using the 

formatting tools and background and background objects. 
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Unit 5 Chapter 10 Digital Presentation 

(Topic-4 : Work With Slides) Page No. 2.207 

 Q. 1 What are the problems with inserting duplicate slides? 
 

Answer : If you may want to insert the same slide as the previous slide of the presentation 

just like the first page of the book has the title of the book and the same title also appears on 

the cover page of the book. This can be done with inserting duplicate slide of an already 

created slide. 

But the problem associated with duplicate slides that it will take all the data, formatting, 

layout and the style as the previous slide, so we need to change those. 

 Q. 2 Explain different methods of inserting new slides? 
 

Answer : We can insert a new slide which have title and content slide by default but we can 

change the layout of the slide. Problem with inserting duplicate slide is, it have the previous 

slide layout and data although we do not required same layout. For inserting new slide we 

need to follow the steps given below – 

Step 1 - Select the slide where you want to insert a new slide. 
 

Step 2 – Press slide on the menu bar and then select new slide tool. 

Or Right click on the selected slide click on new slide tool. 

Or click the New Slide icon in the Presentation toolbar. 
 

 Q. 3 Describe different slide layouts? 
 

Answer : These are the different layouts in the impress - 
 

S.No Layout Description 

1. Blank slide This has no Auto Layout Text Boxes at all. 

2. Title Slide This has a Title box on top and a Subtitle box below. 

3. Title, Content This is the one that is most used. It has a Title box on top, 
and a body section preconfigured for bullet points below. 

4. Title and 2 Content This has a Title box, and under it 2 content boxes side by 
side. Each of the content boxes is preconfigured for bullet 
points. 

5. Title only Just a Title box on top, then blank 

6. Centered text This has no Title box at all, just a body box, and in this case it 
is not preconfigured as bullet points. It has text set up as 

  centered. The style that controls this box is the Subtitle style. 
You can see this when you click on the box to add text and 
check the Styles and Formatting Window. You will see the 
Subtitle style highlighted, which is your indicator. 
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Q. 4 What is the difference between copying and moving an slide? 
 

Answer : Copying means make a copy of the data, we can paste it on the other place. 
 

Moving means we are replacing or removing that data from that place and we can place it on 

the other place using paste. 

 Q. 5 What are different workspace views available in impress? 
 

Answer : There are so many workspace views you can find it from the view tab from the menu 

bar. These views are Normal, Outline, Notes, Slide Sorter, Slide Master, Master Notes, and 

Master Handout. The appropriate view can be selected from the View menu. 

Normal view - This the main view for creating individual slides. Use this view to format and 

design slides and to add text, graphics, and animation effects. To place a slide in the slide 

design area of the Normal view click the slide thumbnail in the Slides pane. 

Outline view - The Outline View contains all of the slides of the presentation in their 

numbered sequence. It shows topic titles, bulleted lists, and numbered lists for each slide in 

outline format. Only the text contained in the default text boxes in each slide is shown. If you 

have added text boxes or graphic objects to the slides, then these objects are not displayed. 

Slide names are not included. 

Notes view - Use the Notes view to add notes to a slide. These notes are not seen when the 

presentation is shown to an audience but they can be printed with the slides. 

Slide Sorter view -   The Slide Sorter view contains all of the slide thumbnails. Use this view 

to quickly sort group of slides or view multiple slides in one window. 

Handout view - The Handout view is for setting up the layout of your slide for a printed 

handout. Click the Handout tab in the workspace and the Layouts section opens on the 

Sidebar. Then you can choose the number of slides per page for the printed handouts. 

7. Title, 2 Content and 
Content 

This has a Title box on top, 2 content boxes stacked on the 
left, and one full content box on the right. 

8. Title, Content and 2 
Content 

Just the mirror image of the previous, with the full content 
box on the left and the stacked boxes on the right. 

9. Title, 2 Content over 
Content 

Title box on top, then 2 side-by-side content boxes, then a 
full width content box beneath them. All content boxes 
preconfigured to use bullet points. 

10. Title, Content over 
Content 

Title box, then a full width content box, then another full 
width content box beneath that. Content boxes are 
preconfigured for bullet points. 

11. Title, 4 Content Title box, 2 side-by-side content boxes, and then 2 more side- 
by-side content boxes beneath them. Content boxes are 
preconfigured for bullet points. 

12. Title, 6 Content Title box, 3 side-by-side content boxes, and then 3 more side- 
by-side content boxes beneath them. Content boxes are 
preconfigured for bullet points. 
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There are some options of views given on the workspace. 
 

Unit 5 Chapter 10 Digital Presentation 

(Topic-5 : Format The Text in Presentation) Page No. 2.214 

 Q. 1 What is font style and size. How it can be changed. 
 

Answer: Font Style is the type of style data is presented on the slide like Times new roman or 

Arial and Font Size is the size of the data presented on the slide. 

Following steps show you a few font related buttons. 
 

Step 1 − Select the portion of text the font of which needs to be changed and click the Font 

Type button to list down all the fonts available. 

Step 2 − Try to move the mouse pointer over the listed fonts. You will see that the text font 

changes when you move the mouse pointer over different fonts. You can use the Font Scroll 

Bar to display more fonts available. Finally select a desired font by clicking over the font 

name in the list. 

Q. 2 Why numbering and bullets are used in the document? How it can be inserted in 

the document? 

Answer: LibreOffice impress provides bullets and numbers just like in writer to put a list of 

items in a nice order. This will teach you simple steps to create either the bulleted or the 

numbered lists in simple steps. 

Create a List from Existing Text 
 

This is very simple to convert a list of lines into a bulleted or numbered list. Following are the 

simple steps to create either bulleted list or numbered list. 

Step 1 − Select a list of text to which you want to assign bullets or numbers. You can use any 

of the text selection method to select the portion of text. 

Step 2 − Click the Bullet Button triangle to display a list of bullets you want to assign to the 

list given in the formatting toolbar. You can select any of the bullet style available by simply 

clicking over it. 

Step 3 − If you are willing to create a list with numbers, then click the Numbering 

Button triangle instead of the bullet button to display a list of numbers you want to assign to 

the list. You can select any of the numbering style available by simply clicking over it. 

 Q. 3 Define different type of text alignments. 
 

Answer: Let us see the text alignment tools. There are four types of paragraph alignment 

available in Writer — left-aligned, center-aligned, right-aligned, and justified. 

Left-Aligned Text 
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A paragraph's text is left aligned when it is aligned evenly along the left margin. Here is a 

simple procedure to make a paragraph text left-aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click the Align Text 

Left button available on the Home tab or simply press the Ctrl + L keys. 

Center Aligned Text 
 

A paragraph's text will be said center aligned if it is in the center of the left and right 

margins. Here is a simple procedure to make a paragraph text center aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click the Center button 

available on the Home tab or simply press the Ctrl + E keys. 

Right-Aligned Text 
 

A paragraph's text is right-aligned when it is aligned evenly along the right margin. Here is a 

simple procedure to make a paragraph text right-aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click the Align Text 

Right button available on the Home tab or simply press the Ctrl + R keys. 

Justified Text 
 

A paragraph's text is justified when it is aligned evenly along both the left and the right 

margins. Following is a simple procedure to make a paragraph text justified. 

Step 1 − Click anywhere on the paragraph you want to align and click the Justify button 

available on the Home tab or simply press the Ctrl + J keys. 

When you click the Justify button, it displays four options, justify, justify low, justify high 

and justify medium. You need to select only the justify option. The difference between these 

options is that low justify creates little space between two words, medium creates a more 

space than low justify and high creates maximum space between two words to justify the 

text. 

 Q. 4 What is formatting bar? Explain different parts of formatting bar? 
 

Answer: Formatting toolbar is use to contain tools related to formatting of the text. There are 

so many tools available in the formatting toolbar as we have already seen in the writer and 

calc. 

Let us see the tools related to formatting toolbar. 
 

S.No Tool Description 

1. Font Style Use to change the writing font of the text 

2. Font Size Use to change the font size of the writing text. 

3. Font Increase Use to increase the font size by 2 points of the writing text. 

4. Font Decrease Use to decrease the font size by 2 points of the writing text. 

5. Bold Use to write bolder then the normal font size. 
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6. Italic Use to write little slanting then normal font. 

7. Underline Use to draw a line under the text. 

8. Strike Use to draw a line through the text. 

9. Super Script Use to write text slight higher and smaller than the normal 
text. 

10. Subscript Use to write text slight lower and smaller than the normal text. 

11. Font Color Use to change or assign font color of the text 

12. Highlighting Color Use to assign or change the background color of the text. 

13. Numbering and 
Bullets 

Use to write text in the form of numbered or bulleted list. 

14. Test Alignment Use to align the text left, center, right and justified. 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Unit 5 Chapter 10 Digital Presentation 

(Topic-6 : Create and Use Table in Presentation) Page No. 2.223 

 

Q.1 What is table ? Why it is used? 
 

Answer: Tables can be inserted on the slide in the impress. Tables are use to represent data 

in a proper and clean manner. 

Q2 Describe different methods to insert a table on the slide? 

Answer: Let us see the steps to add a table on the slide – 

1. Insert table using insert menu 
 

Step 1 – Go to insert menu and then click on the table. 
 

Step 2 – When you click on table you will get an new table window which have number of 

rows and number of columns. 

Step 3 – After selecting number of rows and columns from the arrow buttons or you can also 

insert from the keyboard. Press ok the table will appear on the slide. 

2. Insert table using table Standard toolbar 



36 
 

 

Step 1 - You can also insert table by the table tool given on standard toolbar. When 

you click on the table tool a insert table dialog box will appear where you can select the 

number of rows and columns. 

Step 2 – After selecting number of rows and columns from the arrow buttons or you can also 

insert from the keyboard. Press ok the table will appear on the slide. 

3. Insert table with content section of the slide 
 

Step 1 - You can also insert a table on a slide which has a title and content section, so go to 

the content section and click on the insert table tab. 

Step 2 – When you click on table you will get an new table window which have number of 

rows and number of columns. 

Step 3 – After selecting number of rows and columns from the arrow buttons or you can also 

insert from the keyboard. Press ok the table will appear on the slide. 

 Q. 3 Can the size of row and columns can be changed? Explain? 
 

Answer: Yes we can change the size of row and column. To change the width of the column, 

position on the border line between the two columns, and when the cursor changes to a (↔) 

sign, press the left mouse button, hold and drag it until the column achieves the desired 

width. The same can be done for adjusting the row height. 

 Q. 4 Describe different type of background option available in the table properties tab? 
 

Answer: Table border is the boundary of the table and the background is the color or gradient 

or image or pattern show in the back of the table. This is the part of the table properties 

which can be able to find by different ways. First let us see with the format menu. 

Step 1 - Select Format menu and then click on table tab and then click on properties. 
 

Step 2 - You will able to find a new table properties window which has many properties like 

Font, Font effect, border and background. 

Step 3 – third tab is of border and forth tab is of background. Click on third and select the 

line arrangement, line style, width and color and padding or the distance between text and 

the border. 

Step 4 – select forth tab background this background have different style like gradient, color 

pattern, bitmap and none. Select any one according to your need and then press ok. 

Whatever changes you made will reflect in the page. This is color tool where you can select 

any color. 

The bitmap and pattern are the graphical images likes so we can insert or use them as 

background for the table. 
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Table properties can be accessed with the table formatting toolbar give in the bottom of the 

impress window. 
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And you can also insert this toolbar from view tab and then click on the toolbars and then select 

table toolbar. 

You can also open the table properties window just right click on any cell of the table and 

then select table properties you will get the same table properties window as you get from 

the format tab. 
 

Unit 5 Chapter 10 Digital Presentation 

(Topic-7 : Insert and Format Image in Presentation) Page No. 2.234 

 Q. 1 What is the difference between inserting and image from gallery and file? 
 

Answer: Impress supports multiple content types including images or pictures. Picture is 

Images and photos that are available on your computer or hard drive. Although the sources 

can be different and pictures can be edited. 

Gallery is a collection of pictures or images that can be imported into a document or another 

program. The images may be either raster graphics or vector graphics. Galleries many contain 

anywhere from a few images to hundreds of thousands of images. 

Gallery is typically organized into categories, such as people, objects, nature, etc., which is 

especially helpful when browsing through thousands of images. 

 Q. 2 What all can we can done in formatting? 
 

Answer: Formatting an image includes moving, resizing, rotating an image. The image 

inserted into a presentation can be formatted. 

 Q. 3 How objects can be drawn on the slide? How many type of different objects we have? 
 

Answer: Impress provides various drawing tools. The Drawing toolbar having the majority of 

the tools used to create graphical objects. To activate this toolbar select View menu and then 

click on Toolbars and then click on Drawing toolbar from the main menu bar. We can draw 

line as well as shapes using this toolbar. Let us see how to draw the line and shapes on the 

slides. 

Drawing Line – Line can be draw with the line tool given on the drawing toolbar. 
 

Step 1 - Click on the small triangle to the right of the line tool and select the desired line 

from the available selection. 

Step 2 - Click and drag on the slide to create the line or shape and release the mouse button. 
 

Drawing shapes: As similar to drawing a line, you can draw shapes by selecting the desired 

shapes from the available selection and clicking and dragging on the slide. 
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you can select any shape from the given 

shapes these shapes have the other available examples within the shapes, some of them are 

given below. 
 

An example of drawing some shapes on the slide. 
 

 Q. 4 How grouping is different from ungrouping? What are the advantages of grouping? 
 

Answer: 
 

Grouping – Gathering or selecting more than one object is called grouping. With the help of 

grouping tool we can format all the objects at ones we need not format every object 

separately. For grouping objects we need to follow the some steps – 

Step 1 - Select the objects to be grouped using selection tool on the Drawing toolbar and 

draw a rectangle around the objects to be grouped, or hold down the Shift key and click on 

each object. 
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Or to select all the objects, go to Edit menu and click on the Select All tool on the main menu 

bar or use the keyboard combination Ctrl+A. 

Step 2 - When the selection handles are displayed, use the keyboard combination 

Ctrl+Shift+G or right-click on an object within the selected group and select Group from the 

menu. 

Ungrouping – Ungrouping means deselecting the grouped objects. To ungroup objects follow 

the below given procedure: 

Step 1 - Select the group by clicking on any one of the objects in the group. 
 

Step 2 - When the selection handles are displayed, use the keyboard combination 

Ctrl+Alt+Shift+G or right-click on the group and select Ungroup from the context menu. 

 

Unit 5 Chapter 10 Digital Presentation 

(Topic-8 : Work With Slide Master) Page No. 2.241 

 Q. 1 Define slide master and also define the characteristics of slide master? 
 

Answers: To change the appearance and layout of a presentation you modify or create Slide 

Masters. This is a quick way to style your presentation without spending time modifying a 

master slide. 

A slide master has a defined set of characteristics, including 
 

 the background color, graphic, or gradient 

 objects (such as logos, decorative lines, and other graphics) in the background 

 headers and footers 

 placement and size of text frames 

 and the formatting of text 
 

 Q. 2 Can slide master slide be create? Explain how? 
 

Answers: Yes slide master can use to create slide. A presentation may require different 

designs in some of the slides. In this case Impress allows us to create two or more master 

slides and apply each one to the corresponding slides. 

Step 1 - To create a new master slide click on view menu and then click on master slide. 
 

Or click on the master slide in the slide bar.  

A new master slide is being created and you can start modifying it the same way you modify 

the default master slide. 

 Q. 3 Can we use different slide master in different slides? If yes explain how? 
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Answers: Yes slide master can use different slides. For applying the slide masters to the 

slides, select the slides for which you want to change the layout or master. Then go to slide 

menu and then click on the change the slide master. 

A new window of slide master will appear then select the master you want to select for the 

slides. 

Select the master and then press ok. If you add a new slide then that slide will add with the 

master which is on the last slide. Otherwise if you want to change the master to all the slides 

then you have to select all the slides then change the master slide. 

 Q. 4 What is slide transition? How it can be applied on different slides? 
 

Answers: A slide transition is how one slide is removed from the screen and the next slide is 

displayed during a presentation. PowerPoint offers many entertaining and different slide 

transition schemes- the trick is to be careful not to use too many different schemes in one 

presentation. Be selective and consider the appropriateness of the scheme before you apply it 

to the different slides. Test them out by running the Slide Show and evaluate them for 

effectiveness. 

For adding slide transition we have to follow the some steps – 
 

Step 1 – Click on view menu and select Slide transition 
 

Or click on the slide transition on the slide bar  

Step 2 - Select the type of transition you want for the slide. 
 

Step 3 – Then select the duration of the transition that is the time taken to change the slide. 
 

Step 4 – If you want to control the slide change with the help of mouse then check the on 

mouse click otherwise select the automatically after and give the time required to explain 

the slide. 

Step 5 – If you do not want to apply the same transition to all the slides then click on the next 

slide and then repeat the step 1 to step 5. Otherwise select apply transition to all slides 

button. 
 

To see the transition effect press play it will show the actual transition effects selected by 

you. 
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